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Introduction

Dr Razz is a 16-bit grayscale image display and analysis program for
Macintosh computers. The program has been optimized for display of
radiology image formats, including computed tomography (CT), magnetic
resonance imaging (MRI), computed radiography (CR) and digitized
radiographs.

Program Features
¥ Near real-time window width and window level adjustments on 8 and

16-bit image data.
¥ Images can be viewed individually, or a group of images (e.g., a CT or

MRI scan) can be viewed in an image series.
¥ Many different file formats are supported, including DICOM 3.0,

ACR/NEMA, TIFF, and JPEG/JFIF (including 12-bit grayscale). The program
features advanced algorithms that allow most non-compressed CT and MR
images to be opened even if the specific file format is not supported,
regardless of byte order and image header size. Images created with the GE
Image Extract Tool ('ximg') are well supported, and compressed images
created with this tool are opened automatically.

¥ Patient demographic overlay on the image is supported for
ACR/NEMA, DICOM, Picker and GE ximg images.

¥ Images can be saved as 8/16-bit raster files, 8/16-bit grayscale TIFF
(with LZW, JPEG or deflate compression), 8/16-bit grayscale JPEG, or 8-bit
grayscale PICT or PICS files.

¥ Image processing operations available include flip, rotate, invert,
rescale, sharpen, smooth, Laplacian edge detection, dynamic compression,
histogram equalization and adaptive histogram equalization.

¥ Innovative interface controls include interactive window/level
adjustments, unsharp masking(edge enhancement) and dynamic compression
(density correction).

¥ The core AppleEvents and stationary pad documents are supported.

Program Requirements
¥ System ≥ 7.0 and a color Macintosh with a 68020 or greater CPU are

required, or any Power Macintosh. If the 'Use Internet Config' preference is
selected, then version 2.0 or later of the Internet Config extension must be
present. The application is distributed as a Òfat binaryÓ that contains both the
680x0 and Power Macintosh versions.

¥ Memory requirements depend on the image size. A 256x256 MRI scan
can be viewed in as little as 700k RAM. A 2k Fuji computed radiography
image requires about 16M RAM if unsharp masking is required. For CT
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series, roughly 0.5M RAM is needed for every image after the first image is
loaded. Images can be loaded into either the Dr Razz application memory
partition, or into System temporary memory (see 'User Preferences', below).

Program Configuration
The default user preferences will be adequate for most users. For more
information about the different preferences options, see the 'User Preferences'
section below. Virtual memory may significantly decrease program
performance.  I strongly recommend that you turn off virtual memory,
especially on Power Macintoshes.

The program is optimized for an 8-bit (256 colors) monitor setting. The
user preferences determine if the monitor is switched to 8-bit when the
program is launched.

Known Problems
¥ When the image is magnified, there is a peculiar Ôpixel shiftingÕ when

using the pencil or paint brush tools.
¥ The pencil and paint brush tool do not work with 8-bit images.
¥ There may be a problem with the Apple 8¥24 graphics card that causes

the image to turn black after adjusting the window/level control.

About This Document
This document looks best if the monitor is set to 8-bit (256) or greater colors.
When printing, be sure the color/grayscale printing is selected (Figs. 1 and 2).

Figure 1. Color/grayscale printing option in the ÔPrintÕ dialog
(LaserWriter 7 version).
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Figure 2. Color/grayscale printing option in the ÔOptionsÕ subdialog of the
ÔPrintÕ dialog (LaserWriter 8 version).

Program functions which are not yet implemented or are under development
are displayed in the italic font style:

[this feature is not yet implemented]

Uniform resource locators (URLs), keyboard options and email addresses are
displayed in the Courier font and are bracketed by the greater than and less
than characters:

<http://www.dr-razz.com/>
<Home>, <Page up>, <Page down>

Menus, menu items and dialog options are delimited by single quotes:

'Save All' menu item under the 'File' menu

Registration
Please register your copy of Dr Razz. Registration is easily performed at the
Dr Razz web site.

<http://www.dr-razz.com/register.html>

You have the option of being notified of updates and other Dr Razz related
news.

http://www.dr-razz.com/register.html
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Debug Version
This is a ÒdebugÓ version of the program. If a programming error is
encountered , an Òassertion failureÓ is generated (Fig.Ê3).

Figure 3. The assertion failure dialog.

The error message and other important information is recorded in the file 'Dr
Razz error log'. Please email the file and a description of how the error
occurred to:

<tg3@u.washington.edu>

Bug reports can also be submitted at the Dr Razz web site:

<http://www.dr-razz.com/bug.html>

If your computer is connected to the internet, you can connect to the Dr Razz
web site from the 'Intenet' menu in Dr Razz.

mailto:tg3@u.washington.edu
http://www.dr-razz.com/bug.html
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Tool Bar

The Dr Razz tool bar (beneath the menu bar) (Fig.Ê4) contains most of the
application user interface elements, including the window/level control, the
window/level presets menu, the tools palette, the color picker display and
the pixel value display. The tool bar can be hidden by selecting the 'Hide
Tool Bar' menu item of the 'Windows' menu.

Figure 4. The Dr Razz Tool Bar.
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Window/Level Control
The window/level control determines the 16-bit to 8-bit grayscale mapping
for 16-bit images, and determines the brightness and contrast mapping for 8-
bit images (Fig.Ê5). The control is comprised of the window/level sliders, the
tweak control, and the window/level edit fields.

Figure 5. The Window/Level Control.

The window and level sliders interactively adjust the individual settings.
Clicking in the slider track bar also changes the control setting by
approximately 10%. Holding the <Option>  key increases the control setting
change. The tweak control increases or decreases the control setting by one
unit, permitting very fine adjustment of the window and level setting.
Holding the <Option>  key while selecting the tweak control changes the
control setting by five units.

The current window and level settings are displayed in the window/level
edit fields to the right of the sliders. The settings can be directly edited by
clicking in either field and typing a new control value. Pressing the <Return> ,
<Enter>  or <Tab>  keys applies the new control setting to the frontmost image.
Pressing the <Tab>  key also selects the other control edit field. A
window/level edit field is "active" if it is highlighted (selected) (Fig.Ê6) or if
the field contains a blinking text cursor. The 'Cut', 'Copy', 'Paste' and 'Clear'
menu items under the 'Edit' menu work on an active edit field as per standard
Macintosh practice. To deselect a window/level edit field, click on an "empty"
(non interface) portion of the tool bar.

Figure 6. Active window edit field.

The arrow keys also adjust the window/level settings: the left/right arrows
adjust the window setting, and the up/down arrows adjust the level setting
(Fig.Ê7). Holding the <Option>  key increases the amount of change.
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Figure 7. The arrow keys also adjust the window/level settings.

If a window or level edit field is active, the arrow keys will move the text
cursor in the edit field, and the window/level setting will not be affected. To
deselect the edit field, click on an empty part of the tool bar.

If no image display window is opened, the window/level control is
dimmed (inactive) (Fig.Ê8).

Figure 8. The inactive window/level control.



Tool Bar 8

Window/Level Presets
The window/level settings can be changed by selecting the window/level
presets menu in the tool bar (Fig.Ê9). The presets can also be selected by selecting
the function key (F-key) number listed to the left of the preset menu item. The
window/level presets labels and settings can be edited in the Window/Level
Presets dialog (Fig.Ê10).

Figure 9. The window/level presets menu.
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Figure 10. Window/Level Presets Dialog. The label, window and level fields
can be separately edited. Clicking the F-Key button to the left of the label field

applies the preset to the frontmost image.
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Tools and Cursors
Selecting a tool from the tools palette (Fig.Ê11) changes the current selected
tool and associated cursor icon (Fig.Ê12).

Figure 11. The Tools Palette. The grabber tool is the default.

Each tool is associated with a specific function in the image display window.
¥ selection: select objects
¥ grabber: scroll image
¥ magnifying glass: magnify/minify image
¥ color picker: select pixel value (color picker display)
¥ pencil: replace single pixel with color picker value
¥ paint brush: replace group of pixels with color picker value

Selecting the magnify tool changes the cursor to a magnifying glass with a
plus ('+') in the glass: clicking the cursor in the image display window will
magnify the image. If the <Option> key is pressed, the cursor changes to a
magnifying glass with an internal minus ('-'), which minifies the image. The
magnify tool is limited to 4x magnification and 4x minification. When either
magnification or minification reaches the 4x limit, the magnify tool changes to a
magnifying glass with slash through it (magnify limit icon). If the current image is
magnified or minified, double clicking the magnify tool returns the image to the non-
magnified state.

The cursor icons associated with each tool are shown in Figure 12.
Regardless of the current tool selected, the cursor icon is the arrow when the
cursor is outside of an image window. Depressing and holding the
<space bar>  will convert any cursor icon to the grabber if the cursor is within
an image display window.
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Figure 12. Cursor icons associated with each tool.
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Color Picker and Cursor Value Displays
The color picker display (Fig.Ê13) shows the current color picker pixel value
and grayscale hue for the frontmost image. The grayscale hue is dependent
on the color picker pixel value and the current window/level setting. The
color picker pixel value is selected by the color picker tool in an active image
display window. When an image is opened, the default color picker value is
the minimum pixel value in the image.

Figure 13. The color picker and cursor value display.

The cursor value display (Fig.Ê13) shows the current vertical position (y-axis
location), horizontal position (x-axis location) and image pixel value at the
current cursor location in the frontmost image window.
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Image Display Window

The image display window contains a grayscale or color image. The file name
associated with that window is listed in the window title bar. If a stationery
file is opened, the window title is "Untitled." There is a close box in the upper
left corner, and a window resize icon in the lower right corner. If the image is
larger than the current window size, the grabber tool is used to scroll the
image (Fig.Ê14).

Figure 14. The image display window.

Patient and exam demographics, when present, are displayed in the upper
right corner of the image (Fig.Ê15). They can be Òturned offÓ by selecting the
ÔExam DemographicsÕ menu item under the ÔOptionsÕ menu. Exam
demographics are supported for ACR/NEMA, DICOM 3.0, GE ximg and
Picker image formats.
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Figure 15. Exam demographics displayed in upper right corner.

If multiple image display windows are open, they are stacked from left to
right and from top to bottom (Fig.Ê16). If all opened windows are
subsequently closed, then the next window is opened at the "first" window
position.
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Figure 16. Multiple image display windows.
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Unsharp Mask Control

The unsharp mask control is activated by selecting the 'Unsharp Mask
Control' menu item under the 'Options' menu or pressing the <Cmd-2> key
combination.

Unsharp masking is a common image processing algorithm that increases
the high frequency information in the image (edge enhancement). Dr Razz
features an innovative INTERACTIVE unsharp mask control (Fig.Ê17). The mask
slider adjusts the NxN smoothing convolution kernel size, which affects the
range of frequencies enhanced in the image. A small mask setting will only
enhance the highest frequencies in the image, but increasing the setting will
progressively enhance the lower frequencies in the image. For CT or MRI
scans, a mask of 3 is usually optimum, but for computed radiographs (CR) or
digitized radiographs, larger mask sizes are preferred. The blend slider
adjusts the amount of edge enhancement that is added to the image. The
window and level settings are changed via the window/level control in the
tool bar.

Figure 17. The unsharp mask control.

The unsharp mask control is deactivated (closed) by clicking on the close box
(upper left corner), or selecting either the 'Window/Level Control' or
'Dynamic Compression Control' menu items under the 'Options' menu. When
the control is deactivated, a dialog asks whether the unsharp mask changes to
the image should be retained (Fig.Ê18).
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Figure 18. When the unsharp mask control is deactivated, the user can
keep the changes to the image, revert the image, or cancel the operation.
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Dynamic Compression Control

The dynamic compression control is activated by selecting the 'Dynamic
Compression Control' menu item under the 'Options' menu or pressing theÊ
<Cmd-3> key combination.

The dynamic compression control adjusts each image pixel value based on
the average value of an NxN local neighborhood (Fig.Ê19). The process is
similar to the unsharp masking algorithm described above, but the effect is to
equalize the parts of the image that vary greatly in pixel value. This process is
sometimes referred to as density correction. As with the unsharp mask
control, the mask control adjusts the NxN convolution kernel (local
neighborhood), and the blend control adjusts the amount of density
correction.

Figure 19. The dynamic compression control.

Below the blend control is the 'Type' drop menu that selects the type of
density correction (Fig.Ê20). Selecting the Light option will decrease the
highest pixel values in the image (based on the settings of the mask and
blend controls). Selecting the Dark option will increase the lowest pixel
values in the image, and selecting Both will combine both processes.

Figure 20. Dynamic compression type selection.

An example of the 'Light' dynamic compression type is enhancing the
mediastinum detail on a computed radiograph. An example of the 'Dark'
compression type is enhancing the soft tissue detail in an extremity computed
radiograph or digitized radiograph.

The dynamic compression control is deactivated (closed) by clicking on
the close box (upper left corner), or selecting either the 'Window/Level
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Control' or 'Unsharp Control' menu items under the 'Options' menu. Similar
to the unsharp mask control, when the control is deactivated, a dialog asks
whether the changes to the image should be retained.
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Opening a File

File Types Supported
Many different file formats can be opened using the default 'Auto'
(automatic) image parameters mode. Supported image file formats include:

¥ TIFF: 8-bit and 16-bit grayscale; LZW, JPEG and deflate compression.
¥ JPEG (JFIF format): 8 and 12-bit grayscale (*)
¥ PICT (*)
¥ PNG (portable network graphics format): 8 and 16-bit grayscale.
¥ MCID
(*) color images converted to grayscale

ACR/NEMA and DICOM 3.0 file formats are partially supported -- grayscale,
uncompressed, single image file types.

The following vendor specific formats are at least partially supported.
¥ GE Image Extract Tool (ximg), including compressed formats
¥ Picker CT and MRI
¥ Siemens
¥ Fuji CR (via DASM interface)
¥ Cemax workstations
¥ Highspeed Advantage
¥ SYTEC
¥ Lumysis
¥ Vision10
¥ AFM (Digital Instruments)
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The Open File Dialog
Files can be opened by double clicking on a Dr Razz document in the Finder,
dragging and dropping one or more documents onto the Dr Razz application,
or selecting the 'Open...' menu item under the 'File' menu which opens the
open file dialog (Fig.Ê21).

Figure 21. The Open File Dialog. The automatic image parameters
option is selected.

If the 'Open All' checkbox in the dialog is selected, all the images in the
currently selected directory will be opened (Fig.Ê22). The images can be
opened into individual windows (ÔIndividuallyÕ), or all the images can be
opened into an image series (ÔAs SeriesÕ). All the images must have the same
image dimensions and must have the same file type in order to be included in
an image series. The '<' , '>' , <Home>, <End>, <Page Up>  and <Page Down>  keys
are used to navigate to different images in the series.
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Figure 22. All the images in the selected folder will be opened
as an image series.

If the automatic image parameters method cannot open an image, select the
'Custom' image parameters radio button, and then click the 'Edit' button
(Fig.Ê23) to bring up the custom image parameters dialog (Fig.Ê26).

Figure 23. The Custom image parameters option.

If the 'Same Window/Level' option is selected (FigÊ24), the window and level
settings of the frontmost image window will be used for the new image. The
option is only enabled if an image window is already opened.

Figure 24. Use the window/level settings of the current image.

Balloon help is available in this and other dialogs by selecting the balloon
help checkbox in the lower right corner (Fig.Ê25), or by selecting the ÔShow
BalloonsÕ menu item under the balloon help menu bar icon.
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Figure 25. Balloon help in the open file dialog.

If a stationery document is opened, the image display window title is
"Untitled." If multiple stationery documents are opened, they are titled, in
sequence, "Untitled", "Untitled 2", "Untitled 3", etc.
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Custom Image Import Parameters Dialog
After selecting 'Edit' in the open file dialog, the Custom Import Parameters
dialog allows editing of image width, image height, bit length, and other
image parameters necessary to open an image file not supported by Dr Razz
(Fig.Ê26). Select the ÔOKÕ button to accept the parameters in the dialog, and
select ÔCancelÕ to reject the settings.

Figure 26. Custom Image Parameters dialog.

Image width and image height (in pixels), and header length (in bytes) are
entered in the appropriate edit fields (Fig.Ê27). If the 'Guess Header Length'
checkbox is selected, the image header size is automatically calculated based
on the file size, the image dimensions and the 'bit length' of the image pixels.
For 16-bit image pixels (2 bytes/pixel):

header size (bytes) = file size - [image width x image height x 2]

For 8-bit image pixels (1 byte/pixel):

header size = file size - [image width x image height]

When the 'Guess Header Length' checkbox is selected, the 'Header' edit field
is inactive.
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Figure 27. Image dimensions and header size edit fields.

Image pixel values in CT scans represent Hounsfield units (HU), which is
related to density as follows:

HU = K
µρ − µw

µw







where µρ is the linear attenuation coefficient of the pixel, µw  is the linear
attenuation coefficient of water, and K is a constant that is equal to 1000. Thus
the CT image pixel values range from -1000 for air to over 3000 for dense
objects such as bone or metal. However, the pixel values in CT image files are
often (but not invariably) stored as unsigned integers. To get the correct
Hounsfield unit for such images, select the '-1024' radio button in the 'Offset'
section (Fig.Ê28). The default is '0' (no data offset).

Figure 28. Data offset and truncate options.

If the 'Truncate at 12-bit' option is selected, the image pixel values will be
truncated (limited) to 12-bit contrast range (4096 values). This option can be
useful if the image contains large spurious values not related to the actual
image data.

Pixel parameters important for opening an image file include the size of a
pixel integer (8-bit or 16-bit) and (for 16-bit images) whether the pixel is
signed or unsigned (Fig.Ê29). For 16-bit pixels, the 'Byte order' options include
'Big endian' (Motorola), 'Little endian' (Intel) or 'Guess'. The 'Guess' option
attempts to determine byte order based on the image pixel values.
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Figure 29. Pixel parameters.

The image grayscale values can be inverted by selecting the 'Invert' option
(Fig.Ê29).
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Saving a File

Save
The ÔSaveÕ menu item under the ÔFileÕ menu is active if any alteration of the
image has occurred. Alterations include any image processing operation,
image flip or rotate, and invert. Selecting the ÔSaveÕ menu item, or pressing
the <Cmd-S> key combination saves the current image. Saving an image
replaces the contents of the file associated with the frontmost image window
with the image pixels in the image display window.

Save As
The ÔSave AsÉÕ menu item is active whenever an image display window is
open. The 'Save As...' dialog (Fig.Ê30) appears if the 'Save As...' menu item is
selected from the 'File' menu, or the 'Save' menu item is selected but the
original image file is a stationery document or does not have a supported
save file type. The ÔSave AsÕ operation saves the image pixels in the frontmost
image display window into the new file named in the edit text box below the
ÔSave AsÕ label. The new file is associated with the image display window,
and the original image file is not altered if the new file does not have the same
name as the original file.

The keyboard shortcut for 'Save As' is <Cmd-Shift-S> .

Save A Copy As
The ÔSave A Copy AsÕ menu item is active whenever an image display
window is open. The ÔSave A Copy AsÕ operation saves the image pixels in
the frontmost image display window into the new file named in the text edit
box. However, unlike the ÔSave AsÕ operation, the new file is not associated
with the image display window. This operation is useful in saving multiple
versions of an image without altering the original.

The keyboard shortcut for 'Save A Copy As' is <Cmd-Option-S> .
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Figure 30. The Save As and Save A Copy As dialog.

Save Options
Images can be saved as PICT, PICS, TIFF, JPEG JFIF, PNG or raster (image
pixels without a header) files (Table 2). The file types available depend on
whether the 16-bit or 8-bit option is selected. The file format options are listed
in Table 2. The 'Add Suffix:' option adds an appropriate suffix to the saved
file name. The suffix is displayed to the right of the checkbox label. JPEG files
are interlaced if the ÔInterlacedÕ checkbox is selected. If there are multiple
image display windows opened, the ÔSave AllÕ checkbox is active, and
selecting the check box saves all the open images in the selected file format.

The 'PICS' file format option is only enabled if the front most image
display window is an image series. PICS files are easily converted to
QuickTime movies with utilities distributed by Apple Computer and other
companies.
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JPEG compression quality is adjusted by selecting the small arrows to the
right of the JPEG compression button (Fig.Ê31). A higher number is associated
with higher image quality, but a lower the compression ratio. A compression
quality number of 40 or more often results in little visible degradation of the
image at normal magnification.

Figure 31. JPEG compression quality.

Table 2. Image File Format Options for Saving Files.

File Format 8-bit 16-bit Compression Interlaced
raster yes yes none no
PICT yes no (default) n/a
PICS yes no same as PICT n/a
TIFF yes yes none, LZW, deflate no
JFIF/JPEG yes yes JPEG no
PNG yes yes deflate yes
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Saving JPEG Files
JPEG files can be saved in either 8-bit (1 byte/pixel) or 16-bit (2 bytes/pixel)
format (Table 2). However, 16-bit JPEG files cannot have a contrast resolution
greater than 12-bit (image values from 0 to 4095). When saving a 16-bit JPEG
image with greater than 12-bit contrast resolution, a dialog asks whether to
remap the image to 12-bit contrast resolution (Fig.Ê32).

Figure 32. Saving JPEG image.

Selecting the 'Remap, then save' button will remap the current image to 12-bit
contrast resolution before the image is saved. Selecting the 'Stop' button
cancels the save operation, and leaves the image unchanged. Additionally,
selecting the 'Remap to 12-bit' menu item of the 'Options' menu will also
remap the current image to 12-bit contrast resolution.
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User Preferences

Selecting the 'Preferences' menu item under the 'File' menu opens the
Preferences dialog (Fig.Ê33). User preferences are stored in a file titled 'Dr
Razz Prefs' in the 'Preferences' Folder in the 'System Folder'.

Figure 33. Preferences Dialog.

Switch Monitor To 8-bit On Startup
Dr Razz grayscale images look best when the monitor display depth is set to
8-bit. The always preference will automatically change the monitor to 8-bit
when Dr Razz is started. The never preference does not change the monitor
setting to 8-bit, and the ask user preference displays a dialog on startup
asking if the user wants the monitor changed to 8-bit (Fig.Ê34). The monitor
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display depth is always restored to the original setting when the Dr Razz
application terminates.

Figure 34. The "ask user" dialog.

Restore System Palette
Dr Razz grayscale images use a grayscale palette that also converts the
desktop and other application windows to grayscale display mode. The
open/save file preference restores the original System palette for the open file
and save file dialogs. The switch to Finder/another application preference
restores the System palette when the Finder or another application is selected.
The advantage of switching to the System palette is the original color display
is restored, but the disadvantage is an annoying monitor "flash" (which can
take tens of seconds to complete) while the monitor restores the System
palette.

Default Interface Control
These preference settings determine the default interface control when an
image is opened: window/level, unsharp mask, or dynamic compression.

Default 'Save As' Parameters
These preference settings determine the default file format (PICT, TIFF, JPEG,
etc.), compression (none, JPEG, LZW, deflate), bit depth (8 or 16-bit) and the
use suffix option when the 'Save As' command is selected. However, if the
16-bit option is selected and an 8-bit image is saved, the parameters will
default to 8-bit TIFF with no compression.
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Miscellaneous
The Use Internet Config preference uses the 'Internet Config' extension for
the 'Internet' menu items. The document "Installing Internet Config" explains
the 'Internet Config' extension is more detail.

The Use temporary memory preference uses System "temporary" memory
outside of the Dr Razz application memory partition for loading image data:
deselecting this preference will force all memory allocation to occur within
the Dr Razz memory partition. Most users should select this preference.
However, the temporary memory option should probably be deselected if
virtual memory is enabled.

The Auto convert Finder icons preference automatically converts image
Finder icons to the appropriate Dr Razz icon (see Table 1, below).

The Expand 16-bit TIFF preference expands the contrast resolution of 16-
bit TIFF files to the entire 16-bits. This option is helpful if the TIFF file is
subsequently opened with PhotoShop.
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About Dr Razz Dialog

Selecting the 'About Dr RazzÉ' menu item under the Apple men, or pressing
the <F15> function key, displays the About Dr Razz dialog (Fig.Ê35). Clicking
the mouse anywhere within the dialog will close the dialog.

Figure 35. About Dr Razz dialog.

The dialog displays information about permissible program distribution,
copyright, contact information, amount of available memory, registration
information, and the version of the program. The available memory:
application section displays the amount of memory available in the
application memory partition. The available memory: temporary section
displays the amount of available memory in System temporary memory. Dr
Razz can use System temporary memory if that option is selected as a user
preference (see 'User Preferences', page 32).
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Info Window

The Info window (Fig.Ê36) displays information about the image, including
the file name, width and height of the image, minimum and maximum image
pixel values, and the size of the image (not the size of the image file).

Figure 36. Info window.

The info window is opened by selecting the 'Get Info' menu item under the
'File' menu. The info window can be closed by either clicking the close box, or
by pressing the <Delete>  key.
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Finder Icons

The following table illustrates the Finder icons associated with the Dr Razz
application.

Table 1. Dr Razz Finder icons.

Finder Icon Stationary
Document

Explanation

n/a The Dr Razz application

n/a Preference file (Preferences

Folder, System Folder)

Raster image file (pixels with no
header)

Binary image file (image and
header)

PICT file.

TIFF file.

JPEG (JFIF format) file

ACR/NEMA, DICOM 3.0 file

If the Finder icon of an open document does not match the image file format,
the ÔConvert Finder IconsÕ menu item is enabled under the 'File' menu.
Selecting this menu item changes the Finder icon to match the image file type.
Selecting the 'Auto convert Finder icons' user preference will automatically
convert the Finder icon to the appropriate Dr Razz icon.
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Image Processing

The 'Edit', 'Options' and 'Enhance' menus offer a variety of image processing
operations. Operations that change image orientation can be performed on 8-
bit and 16-bit images, but operations that change the appearance of an image
can only be performed on 16-bit images.

Edit Menu

Images can be rotated 90° counterclockwise with the Rotate Left operation,
and 90° clockwise rotation with the Rotate Right operation. The Flip
Left/Right command performs a 180° horizontal rotation, and the Flip
Top/Bottom command performs a 180° vertical rotation.

Images can be reduced in size by 50% by the Rescale to 50% operation,
and can be reduced to 25% of original size by the Resize to 25% operation.

The Invert operation inverts the image grayscale.
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Options Menu

The interactive Window/Level Control, Unsharp Mask Control and
Dynamic Compression Control (Figs. 5, 17, 19) are described in previous
sections.

An 8-bit (1 byte/pixel) image can be converted to a 16-bit (2 bytes/pixel)
by the Convert 8-bit Image to 16-bit operation. The operation also expands
the contrast resolution from 8 to 10 bits. An 8-bit image must be converted to
a 16-bit image before most image processing operations can be performed.

The contrast resolution of a 16-bit image can be expanded or compressed
to 12-bit by the Remap to 12-bit operation.

Enhance Menu

The Smooth operation blurs the image using a 3x3 blurring convolution
kernel.

 1  1  1
 1  1  1
 1  1  1

Holding the <Option>  key while selecting the menu item will increase the
amount of smoothing by using a 7x7 kernel.
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The Sharpen operation enhances the high frequencies ("sharpens") in the
image using an unsharp mask operation with the following convolution
kernel.

 0 -1  0
-1  5 -1
 0 -1  0

Holding the <Option>  key while selecting the menu item will increase the
amount of sharpening with the following convolution kernel:

-1 -1 -1
-1  9 -1
-1 -1 -1

The Laplacian operation enhances the edges in the image, with the
following kernel:

 0 -1  0
-1  4 -1
 0 -1  0

The Histogram Equalization operation redistributes the image pixel
values based on the grayscale histogram so that the number of pixels at any
one grayscale is about the same. Although the operation is often useful in
image enhancement and restoration, the effect on many medical images is
unsatisfactory.

The Adaptive Histogram Equalization performs a histogram equalization
on each pixel based on an NxN local neighborhood (i.e., surrounding pixels).
The technique is impractical without significant hardware or software
optimization. An article that describes the adaptive histogram equalization
algorithm used by Dr Razz is listed in the 'References' section.
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Internet Options

For computers connected to the internet, the 'Internet' menu allows quick and
easy access to a variety of Dr Razz related internet functions. For this menu to
work correctly, the Internet Config system extension, which is included with
the Dr Razz distribution, should be installed. The Internet Config extension
determines which web browser and other internet programs perform the
internet functions.

¥ Dr Razz Web Site  - go to the Dr Razz web site.

¥ Comments and Suggestions - submit comments about the program.

¥ Submit a Bug Report - report any problems with Dr Razz.

¥ Download Latest Version - FTP the latest version.

¥ Email the Author - send an email message to the author of Dr Razz.

¥ Register - register your copy of the program.
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Keyboard Shortcuts

¥ Window/Level control: left and right arrow keys change the window
setting, and the up and down arrows change the level setting. When the
window setting is below 200, the window and level settings are changed
more slowly with finer resolution. Pressing the <Option>  key increases
magnitude of change with arrow keys.

¥ Image series : '<' and '>' keys (without command key) go to next and
previous image. On extended keyboards, <Home> and <End> go to first and last
image, while <Page Up>  and <Page Down>  keys go to next and previous image.

¥ Nearly all of the controls in the 'Open' and 'Save' dialogs have keyboard
shortcuts. Most are obvious in context.

¥ The <~> or <F15>  keys on the extended keyboard open the 'About Dr
Razz' dialog. Clicking the mouse will close the dialog.

¥ Holding the <space bar>  while the cursor is in an image display
window will change the cursor to the grabber tool.

¥ Menu shortcuts: <Cmd-Shift-S>  opens the 'Save As' dialog; <Cmd-Option-

S> opens the 'Save A Copy As' dialog; <Cmd-Shift-I>  opens the 'Import' dialog.
¥ The image info window can be closed by pressing the <Delete>  key.
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Miscellaneous

Acknowledgments
Alan Rowberg has been very helpful in deciphering obscure image file
formats. Michael Richardson, Alex Baxter, Robert Crockett, Matti Haveri and
Clifford Solomon have provided very helpful user feedback. I would like to
thank the many people who have submitted bug reports and provided
valuable feedback. I am especially grateful to anyone who submitted an
image file to decipher.

The following source code and resource contributions are gratefully
acknowledged:

¥ TIFF support (libtiff), by Sam Leffler, release 3.4.
¥ JPEG code by the Independent JPEG Group, release 6b.
¥ deflate compression (zlib) by Jean-loup Gailly and Mark Adler, release

1.1.3.
¥ More Files 1.4.8, by Jim Luther.
¥ JimÕs CDEFs, by Jim Stout, release 1.5.
¥ Infinity Windoid 3.0, by Troy Gaul.
¥ libmoto (optimized math and string library), Motorola, Inc.

The Dr Razz user interface was designed with the ToolsPlusª and
SuperCDEFsª development system. "Portions of this application © 1989-1998
Water's Edge Software. All rights reserved." Additional information is
available at <http://www.interlog.com/~wateredg/> .

Copyright Notice and Disclaimer of Warranty
Dr Razz is a "freeware" application. You may distribute or repost this
program for non-commercial use. Please include all documentation that is
supplied with the program.

This software is copyright © 1995 - 1998 Thurman Gillespy III. All Rights
Reserved. The author makes NO WARRANTY or representation, either
expressed or implied, with respect to this program, its quality, accuracy, or
fitness for a particular purpose. This software is provided "AS IS", and you, its
user, assume the entire risk as to its quality and accuracy.
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Contact Information
General comments about the program and inquiries to the author can be
emailed to:

<tg3@u.washington.edu>

Written inquiries can be sent to:

Thurman Gillespy III, MD
Department of Radiology, 357115
University of Washington
1959 NE Pacific St.
Seattle, Washington, USA

Where To Get Dr Razz

¥ Dr Razz Web Site

<http://www.dr-razz.com>

About That Name
ÒRazzÓ is a pun on the word Òraster.Ó The proper spelling is ÒDr RazzÓ,
without any punctuation (no period after 'Dr').

mailto:tg3@u.washington.edu
http://www.dr-razz.com/
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1993; 6:197-204.
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More information about the Journal of Digital Imaging can be found at:

<http://www.scar.rad.washington.edu/SCAR/publications.html>

http://www.scar.rad.washington.edu/SCAR/publications.html
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deflate 1, 20, 42
JPEG 1, 20, 29
LZW 1, 20

contrast resolution 30, 38
convolution kernel 16, 18, 39
copyright 34, 42
cursor icons 10
cursor value display 12
custom image import parameters
dialog 24
custom image parameters dialog
22
debugging 4

assertion failure 4
DICOM 1
disclaimer of warranty 42
Dr Razz Web Site 43
dynamic compression 1

Both 18
Dark option 18
Light option 18

type selection 18
dynamic compression control 18
email 40
file format 1, 32

16-bit 28
8-bit 28
ACR/NEMA 1, 13, 20
AFM 20
Cemax 20
DICOM 1, 13, 20
Fuji 20
Highspeed Advantage 20
Image Extract Tool 1, 20
interlaced 28
JFIF 1, 28
JPEG 1, 20, 28
Lumysis 20
MCID 20
Picker 13, 20
PICS 28
PICT 20, 28
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